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EBA 2021 EU-wide transparency exercise

dataset and data visualization tools

For the 2021 EU-wide Transparency Exercise, the EBA published bank-by-bank data contained in
16 transparency templates (on average more than 10 000 data points per bank). This exercise
provides detailed data for 120 banks from 25 countries of the European Union (EU-27) and the
European Economic Area (EEA). Along with the dataset, the EBA also provides a wide range of
interactive tools that allow users to compare and visualise data across time and at a country and a

bank-by-bank level.

User guide for the Transparency dataset

The dataset has been released to the wide public in CSV format, which can be imported into any
analytical software for analysis purposes. Please notice that the CSVs have been developed using
English (UK) settings, therefore User’s System and MS Excel language settings in English (UK) are
required for a correct formatting of the data, with specific reference to the setting of the decimal

separator.
The transparency exercise dataset is stored in four CSV files. They include all the bank-by-bank
data contained in the transparency templates, grouped into specific data categories to reflect the

content of one or more transparency templates, as shown in the table below:

CSV file name Transparency template(s)

Credit Risk_STA, Credit_Risk_IRB, NPE, Forborne Exposure,

Breakdown of loans and advances to non-financial corporation
Credit risk (NACE), Collateral valuation - loans and advances, Information on

loans and advances subject to legislative and non-legislative

moratoria in accordance with EBA Guidelines EBA/GL/2020/02
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Market risk Market Risk

Sovereign exposures Sovereign

Key metrics, Capital, Leverage, Risk Exposure Amount, P&L, Assets,
Other templates
Liabilities

With the CSV files, users will find the data dictionary table and the metadata table, which are helpful
for understanding the file’s database structure (as the four databases have different structures),

and for setting up queries for data extraction and management.
The example below shows how to use and query the EU-wide transparency exercise database. The

files are converted into spreadsheets, allowing the use of standard analytical tools embedded in

Excel.

A practical example: Loans and advances subject to legislative and non-legisative moratorium

(granted and active) broken down by sectors and by performing status, for the EU aggregate for

June 2021

i) Once you have downloaded the CSV file containing data on loans and advances subject
to legislative and non-legislative moratoria (tr_cre.csv), import it into Excel using the
Import “From Text/ CSV” command located under the Data tab:

Bookl - Excel

Insert Page Layout Formulas E Review View Developer Add-ins
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‘ file,
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Locate the file and open through the wizard, by clicking on LOAD:

o X
tr cre.csv
File Origin Delimiter Data Type Detection
| 1252: Western European (Windows) ~ | |_Comma > | i_Ba sed on first 200 rows 4 D},
LEl_Code NSA Period Item Label Portfolio Country Country_rank Ex

OW2PZIMBXOY22MAGGEEES | DE 202009 | 2120502 | Original Exposure - by exposure class (SA_and_IRB) 2 a (1] i
OW2PZIMBXOY22MAGGEEE3 . DE 202009 2120502  Original Exposure - by exposure class (SA_and_IRB) 2 7} o
OW2PZIMBXOY22MAGGEEE3 . DE 202009 | 2120502 Origi.nal Exposure - by exposure class (SA_and_IRE) 2 a o
OW2PZIMBXOY22MAGGEEE3 . CE 202009 | 2120502 | Original Exposure - by exposure class (5A_and_IRB) 2 a 7]
OW2PZIMBXOY22MAGGEEE3  DE 202009 . 2120502 | Original Exposure - by exposure ciass (SA_and_IRB) 2 a a
OW2PZIMEXOY22IMAGGESEE3 . DE 2020089 | 2120502 | Original Exposure - by exposure class {SA_and_IRB) . 2 . 10 1
OW2PZIMBXOY22MAGGEE3 . DE 202009 | 2120502 | Original Exposure - by exposure class (SA_and_IRB} . 2 . 10 i
OW2PZIMBXOY22MAGGEES | DE 202009 | 2120502 | Original Exposure - by exposure class {5A_and_IRB) 2 10 1
OW2PZIMBXOY22MAGGEEE3 . CE 202009 | 2120502 | Original Exposure - by exposure class (SA_and_IRB) 2 10 1
OW2PZIMBXOY22MAGGEEE3 . DE 202009 2120502  Original Exposure - by exposure class (SA_and_IRB) 2 10 1
OW2PZIMBXOY22MAGGEEE3 . DE 202009 | 2120502 Origi.nal Exposure - by exposure class {SA_and_IRB) 2 30 2
OW2PZIMBXOY22MAGGEE83 . DE 202009 | 2120502 | Original Exposure - by exposure class (5A_and_IRB) 2 30 2
OW2PZIMBXOY22MAGGERS | DE 202009 | 2120502 | Original Exposure - by exposure class {5A_and_IRB) 2 30 2
OW2PZIMBXOY22MAGGEEE3 . DE 202009 | 2120502 | Original Exposure - by exposure class [5A_and_IRB) . 2 . 3Q 2
OW2PZIMBXOY22MAGGEES . DE 202009 2120502  Original Exposure - by exposure ciass (SA_and_IRB} . 2 . 30 2
OW2PZIMBXOY22MAGGEERS | DE 202009 | 2120502 | Original Exposure - by exposure class {54_and_IRB) 2 43 3
OW2PZIMBXOY22MAGGEE3 . bE 202009 | 2120502 | Original Exposure - by exposure class (SA_and_IRB) 2 43 3
OW2PZIMBXOY2IMAGGEEER3 . DE 202009 | 2120502 | Original Exposure - by exposure dass {SA_and_IRB) 2 43 =
OW2PZIMBXOY22MAGGBE3 . DE 202009 | 2120502 Origi.nal Exposure - by exposure class {SA_and_IRE) 2 43 3
OW2PZIMBXOY22MAGGEEE3 . CE 202009 | 2120502  Original Exposure - by exposure class (SA_and_IRB) 2 43 3 v

< >

: Transform Data . Cancel

ii) The database structure will appear as shown below:

[E] properties ~ Header Row First Column | Filter Button | i EEEEE EEEEE SoEEd Sooas

File Home Insert Page Layout Formulas Data Review View Developer Add-ins Help ACROBAT SAS Table Design Query

Table Name: Summarize with PivotTable ’f\m @ D
=y o

tr_cre B} Remove Duplicates it | ot Aefvcon DB Openin Brauses Total Row Last Column
‘B Resize Table | G Convert to Range Slicer - ~  SSUnlink ~ Banded Rows | | Banded Columns
Properties Tools External Table Data Table Style Options Table Styles
12 T B0
4| A B c D E F G H | J K 3 M N
1 [N 3 nsa B period B item B Label B footnote B
2 0W2PZIMBXOY22MAGGE83 DE 202009 2120502 Original Exposure - 2 0 o 103 o o 0 382.3940814
3 |0W2PZIMBXOY22MAGGES3  DE 202009 2120502 Original Expasure - 2 0 0 203 0 0 0 19479.43854
4 OW2PZIMSXOY22MAGGSS3 DE 202009 2120502 Original Exposure - 2 0 0 303 0 0 0 309614391
5 |DW2PZIMBXOY22MAGGSS3  DE 202009 2120502 Original Exposure - 2 0 0 404, 0 0 0 0
6 DW2PZIMBXOY22MAGGS83 DE 202009 2120502 QOriginal Exposure - & o o 606 o o o 364.746218
7 |0W2PZIMEXOY22MAGGEE3 |DE | 202009 2120502 Original Exposure - 2 ag 2 0 0 0 0 0
8 0W2PZIMBXOY22MAGGE83 DE 202009 2120502 Original Exposure - 2 10 1 203 o o o 5891.51714
9 |0W2PZIMBXOY22M4GGE83 DE 202009 2120502 Original Exposure - 2| 10 1 303 0 o 0 8011.225467
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iii) The database structure is explained in a metadata file, in which you will find a description of
all the values that each column can assume. The dataset tr_cre has the following columns:

- NSA: ISO code of the bank’s country;

- Lei_code: a bank identifier;

- Item: code of each variable;

- Label: decodification of the item;

- Period: time period (in format YYYYMM, eg: 202103 for March 2021, 202106
for June 2021);

- Portfolio: credit risk approach

- Country: Country code of the country of the counterparty

- Country_rank: Ranking number 1 to 10 of the reported countries of
counterparty

- Exposure: Sectors of exposure

- Status: defaulted or not defaulted status

- Perf Status: performing or not performing status, and subcategories

- NACE_codes: business activities according to the NACE (Nomenclature des
Activités Economiques dans la Communauté Européenne / Statistical
Classification of Economic Activities in the European Union)

- Amount: value that the variable assumes;

- Footnote: specific bank clarification as disclosed in the bank’s PDF, added to
all the items of the relevant templates.

Users can find decoding information either in the metadata file (TR_Metadata.xlsx) and/or
in the data dictionary file (SDD.xIsx).

For each dimension used in the dataset you will find a dedicated tab in the Metadata file,
where the information to decode the specific dimension is included. For instance, in this
example we are interested in the Exposure dimension, you can see the values that the
dimension assume in the dataset, and find the relevant explanation for this.
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TR_Metadataxlsx - Excel o= ]

Insert Page Layout Formulas  Data  Review View  Developer  Add-ns  ACROBAT  SAS @ Tellme.. Angelica.. Q Share

A-D % Cafior BN PP General = ConditiunalFurmat‘ting' %"\nser‘t - X ’Z‘Yv B ==
B - - oo s L:‘FormatasTab\e' & Delete ~ mv P~
fet A B I &0 .0g T . * Webex Select
- - 0 3.0 G Cell Styles ~ Formatr | & v - Visible Gells
Clipboard & Fant o Alignment ml Number Styles Cells Editing Mew Group A
c51 b fe || 700 v
A . B C D | E
1
2
3 Exposure | Label
a4
5 0 Total / No breakdown
6 101 Central banks
it 102 General governments
8 103 Central governments or central banks
9 104 Regional governments or local authorities
10 105 Public sector entities
11 106 Multilateral Development Banks
12 107 International Organisations
12 N Cradit inctitutinne ¥
4+ » .| Financalinstruments Exposure | Status | Perf status | MK . () 4] ] [*]
Ready &9 Average: 709.2  Count 5 Sum: 3546 B L e | — 4 145%

In order to facilitate the data analysis, you can convert the numeric Exposure dimension
into the correspondent description, by inserting an Excel function which will read the Metadata

file directly into the dataset.

Bookl - Bxcel

File Home Insert Page Layout Formulas Data Review View Developer Add-ins Help ACROBAT SAS Table Design Query

4 Cut Calibri Ju AN | =E=2 # | wepTet @ General B @ Normal
(B copy ~
Paste o el e g Sensitivi = Conditional Format as d
B T U« |lts | vk ¢ | =2==|5=52 | & M At ¥ | @ 9 €0 .00 Gool
- ﬂyFormatPamtEr - - = e D B - o /0 2 o Formatting ~  Table »
Clipboard m Font Styles
13 b p 2 =VLOOKUP([@Exposure],'[TR_Metadata (web) to be updated.xIsx]Exposure'!SC:$D,2,0)

A | B s
B s B period B item B Label B2 portfolic BE country B country raBd exposure B3

i

2 | OW2PZIMBXOY22MAGGS83  DE 202009 2120502 Original Exposure - 2 o o 103 Central governments or o
3 |oW2PZIMBXOY22MAGGES3  DE 202009 2120502 Original Exposure - 2 o ¢ 203|Institutions I 0
4 |0OW2PZIMBXOY22MAGGES3 DE 202009 2120502 Original Exposure - 2 0 o 303 Corporates o
5 |0W2PZIMBXOY22MAGGESS  DE 202009 2120502 Original Exposure - 2 o o 404 Retail 0
6 |OW2PZIMBXOY2IMAGGEE3 DE 202009 2120502 Original Exposure - 2 o o 606 Equity exposures o
7 |OW2PZIMBXOY22MAGGBE3  DE 202009 2120502 Original Exposure - 2 10 1 103 Central governments or o
£ |OW2PZIMBXOY22MAGGS83  DE 202009 2120502 Original Exposure - 2 10 2k 203 Institutions o
9 |0W2PZIMBXOY22MAGEES3  DE 202009 2120502 Original Exposure - 2 10 i 303 Corporates 0
10 |OW2PZIMBXOY22MAGGEE3  DE 202009 2120502 Original Exposure - 2 10 I 404 Retail o
11 | 0W2PZIMBXOY2IMAGGE83  DE 202009 2120502 Original Exposure - 2 10 gat 606 Equity exposures 0
12 |OW2PZIMBXOY2IMAGGEE3 DE 202009 2120502 Original Exposure - 2 30 2 103 Central governments or o
13 |OW2PZIMBXOY22MAGGBE3  DE 202009 2120502 Original Exposure - 2 30 2 203 Institutions o

You can do the same for any of the dimension included. In this example it is done for the

Perf_status dimension.
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iv) Now click on ‘Pivot table’, under the Insert tab, and select the entire dataset (or a
subsample if you have already filtered the data you need) as the pivot table range. Set
up the pivot table structure, dragging the variable ‘Exposures_decoded’ into the box
‘Row Labels’ and the variable ‘Perf_status_Decoded’ into the box ‘Column Labels’.

Drag ‘Label’ into the box ‘FILTERS’ to select the item ‘Gross carrying amount on Loans and
advances subject to active EBA-compliant moratoria’ and show only the information for this
item.

Drag period into the box Filter to filter out data for the last quarter only (period=202106).
Finally, you may drag in the box Values the variable Amount, where the variables’ values are

stored, and aggregate it by the sum.

i _
Value Field Settings (.2 [oben

Source Mame: Amount

Custom Name: | Sum of Amount

Summarize Values By | Show Yalues As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

v) The final result should be as shown below:

Fle ~ Home Insert  Pagelayout  Formulas Data  Review  View Developer  Add-ins  Help  ACROBAT  SAS

& Cut Calibri JudE R | ==& | BwepTet @ General 3 =) % Normal Bad &8 &=
mcopy ~ i
Paste Sensitii Conditional Format as ' Insert Delete
B IU- v S A N | g e m Good Neutral =
« < Format Painter U~ |H - Meroe Secuser - % 9| %8 Formatting~ Table ~ - ~
Clipboard ] Font 5 Alignment il sensitiity Number 5 styles cels
8 3
A B c D E F G H
Gross carrying amount
on Loans and advances
subject to active EBA-
1 |Label compliant moratorial-T|
2 |period 202106 X
3
4 |Sum of Amount Column Labels
No by  Non ing Non ingOf  Non ing OF ing ing - of which ing Of which:
Perf status which: which: with ith
exposures with Unlikely to pay that are forbearance measures significant increase in
forbearance measures  not past-due or past- creditrisk since initial
due <=90 days recognition but not
5 Row Labels - credit-impaired (Stage.
6 |Households 59,813 1570 817 1331 58,244 2,003 8,820
Households of which: Collateralised by
7 |residential i property 53,962 1,25 702 1,088 52,708 1,558 5,920
& |Non-financial corporations 63,041 4,045 1,951 2172 52,996 4,901 25,975
Non-financial corporations - Collateralised
9 |by commercial immovable property 29,131 2,107 1,020 1805 27,04 2,823 1732
Non-financial corporations - Small and
10 Medium-sized Enterprises 47,780 2,926 1468 2,386 44,854 3,713 19,848
11 Total / No breakdown 124,735 5,636 2 1521 119,099 6,957 35,068
12
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User guide for the data visualization tools

A set of online data visualisation tools have been published at the EBA website, along with the full
dataset and the individual banks’ results.

Six data visualization tools are available for the users to explore transparency data for the individual
banks as well country/EU aggregates:

e Overview (Visual exploration tool), including the main EBA Risk Indicators that can be
recalculated using the transparency dataset

e Key Metrics, Capital, Leverage, P&L, RWAs, Assets and Liabilities

e NPE and forborne exposures

e NACE
e Sovereign
e Covid-19

The tools are to be open in a browser via links provided at the EBA website.
To navigate between the pages the menu at the bottom can be used, either using the arrows,

or by double clicking on it and selecting from the list:

ital: CET1 Transitional

Capital: CET1 Fully Loaded

Leverage: Tier 1 Transitional
Leverage: Tier 1 Fully phased-in
Assets: Stage 3 : % of Total Loa...

Assets: Coverage ratio Stage 3 ...

Loans: Share of Non-performin...

Loans: Coverage of Non-perfor...

g from the onginal PDF 1. z5 published by the EBA,

1of 1 >
In order to display the figures for a particular country or bank a selection can be made by using the
lists (country codes / flags or bank names). The filters will be applied to the data.
2021 - EU Wide Transparency Exercise EBA i
| Main indicators: (1 of 1)

A CET1 capital ratio (Transitional) CET1 capital (Fully loade} v B2 eee Leverage ratio (Transitional definition of Leverage ratio (Fully phased-in
& = Tier 1) definition of Tier 1)
B:

' 158% ’ 155% 5% M 57%

NGS 5.4 INPL - Share of non-performing loans Coverage ratio of non-performing loans [ll Net interest income to total operating Cost to income ratio
and advances and advances income

: 64.0%
55.0%

\L_ 2.3% 4430/0 5500/0 i 6400/0

100.0% 00% 100.0%
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It is also possible to show figures aggregated for multiply countries/banks.

In order to do so, press CTRL + chosen countries/banks:

2021 - EU

F’ o s - = - - -
e | | = Main indicators: AT, BE (1ot 1)
i || —
N . TR [T
: Tier 1) definition of Tier 1)
AXA Bank Belgium 5 _—
BG cY
. - BAWAG Group AG A A

Transparency data can be explored in the tools directly, but it can be also exported outside.

In order to copy the data from the tables in the tools, users shall follow the steps:

- Click on the header of the chosen column (or select multiply columns by CTRL + ) to select
the data
- Right click on the header and choose Copy = Copy selection

CET1 Ratio Transitional by Country
de Volksbank ... i
gon oo 3non A -
Show as a table _
Austria BNG Bank N.V. |
Belgium Include m
. Bpifrance 5.A.... &
Bulgaria Exclude 2 .
Cyprus
Copy » Copy value
Denmark
Estania 12.6% 13.0% Copy selection g
Finland 16.9% 16.8%
France 14.7% 15.0% SFIL F
Germany 14.2% 14.7%

- UBS Europe 5... I.
Greece 14.9% 14.8% =
Hungary 14.0% 13.9% 3 Landsbankinn... !
lceland 21.5% 21.7% -

Copied figures can be pasted to other programs, e.g. Excel, and used for further analysis:

AutoSave (@ off

File Home Insert Page La' Formula Data Re

Al g

4 A B = D |
1 |Country |Date CET1 Ratiq) Transitional

2 |Austria Mar-20  13.10%

3 |Austria Jun-20  13.80%

4 |Belgium Mar-20  18.00%

5 |Belgium Jun-20  18.60%

6 |Bulgaria  Mar-20  15.60%

7 |Bulgaria | Jun20  15.70%




